
KOMPOZİT MALZEME 
TASARIMI VE MODELLENMESİ



1. Kompozit Nedir?
Kompozit malzeme; iki ya da daha fazla sayıda farklı malzemenin en iyi özelliklerini tek bir
malzemede toplamak amacıyla, makro-düzeyde birleştirilmesiyle oluşturulan yeni malzemedir [1-5].



i.Kompozit Malzeme Oluşturma Amaçları

• Rijitlik

• Kırılma tokluğu

• Yüksek sıcaklık özellikleri

• Elektrik iletkenliği

• Hafiflik

• Çekme dayanımı

•Aşınma dayanımı

•Yorulma dayanımı

•Korozyon dayanımı

•Termal iletkenlik

•Akustik iletkenlik

•Ekonomiklik

•Estetik görünüm



i.Kompozit Malzeme Oluşturma Amaçları

Şekil 1. Kompozitlerin mühendislik malzemeleriyle karşılaştırılması [6]



i.Kompozit Malzeme Oluşturma Amaçları

Şekil 2. Kompozitlerin özelliklerini etkileyen faz parçacıklarının çeşitli geometrik ve konumsal özelliklerinin 
şematik gösterimi [7]



ii. Kompozit Malzeme Kullanım Alanları

Şekil 3. Kompozit malzemelerin  otomotiv sektöründeki kullanım alanları [8]



ii. Kompozit Malzeme Kullanım Alanları

Şekil 4. Kompozit malzemelerin havacılık sektöründeki kullanım alanları [8]



iii. Kompozit Malzeme Yapımında Temel 
Maddelera. Matris Malzemeleri

Ana malzeme/faz olarak ifade edilen matris malzeme polimer, metal, metal alaşımlı, seramik esaslı
malzemelerden oluşur. Matrislerin 3 temel fonksiyonu vardır:

1) Elyafları bir arada tutmak

2) Yükü elyaflara dağıtmak ve

3) Elyafları çevresel etkilerden korumaktır.
Şekil 5. Kompozit Malzemede Arayüzey oluşumu [9]

Şekil 7. Kompozit Malzeme Yapısı [11]

Şekil 6. Sandviç kompozit yapı örneği [10]



iii. Kompozit Malzeme Yapımında Temel 
Maddeleri. Reçineler ve Özellikleri

a. Epoksi Reçine Matrisler
Epoksiler iki ya da daha fazla epoksit içeren bileşenlerden oluşurlar. Polifenol’ün epikloridi ile bazik
şartlarda reaksiyonu sonucu elde edilirler.

Avantajları

• Kapma mukavemetleri yüksektir.

• Elyaf yapılarda yüksek bağ mukavemeti sağlarlar.

• Yüksek aşınma direncine sahiptirler.

• Uçucu değildirler ve kimyasal dirençleri yüksektir.

• Düşük ve yüksek sıcaklarda sertleşebilme özelliğine sahiptirler.

Kullanım Alanları: Temel olarak uçak-uzay uygulamalarında

Şekil 8. Epoksi reçine kullanım yerleri ve şekilleri [12-13]



iii. Kompozit Malzeme Yapımında Temel 
Maddelerb. Polyester Reçine Matrisler

Polyester matrisler dibazik asitlerin, dihidrik alkoller (glikol) yada dihidrik
fenollerle karışımının yoğuşması ile şekil alırlar. Polyesterlerin ana tipleri
polyester bileşeninin doymuş asitle yada alternatif malzeme olarak glikolle
modifikasyonu temeline dayanır.

Avantajları

• Takviyelerin nemini dışarı kolayca atabilmesini sağlayan düşük
vikozite

• Düşük maliyet

• İyi çevresel dayanım

Kullanım Alanları: Genel olarak otomotiv, denizcilik, kimya ve
elektriksel uygulamalarda

Şekil 9. Cam elyaf takviyeli polyester reçine kullanılmış uçak  
[14]

Şekil 10. Dekoratif amaçlı polyester reçine kullanımı 
[15]



iii. Kompozit Malzeme Yapımında Temel 
Maddelerc. Vinylester Reçine Matrisler

Polyester reçinelere benzerler. En önemli avantajları elyaf ve matris arasında
iyileştirilmiş bir bağ mukavemetine sahip olmalıdır. Polyesterle glikolün bir
kısmının yerine doymamış hidrosilik bileşenlerin kullanılması ile elde edilirler.

Korozif ortamlardaki kullanımlar için donatılı plastik bileşenlerin üretiminde
yararlanılmaktadır.

Bu polimerler kimyasal dayanım gerektiren kimya tesislerinde, borularda ve
depolama tanklarında kullanılmaktadır.

Kullanım Alanları: Spor ekipmanları, kimyasal konteynerler, basınçlı kaplar,
savunma sanayi uygulamalarında

Şekil 11. Vinilester reçine kullanım alanları [16]



iii. Kompozit Malzeme Yapımında Temel 
Maddelerd. Fenolik Reçine Matrisler

Fenolik reçinelerin ısı stabiliteleri, elektrik özellikleri, suya ve alkaliler dışındaki
kimyasal maddelere dayanımları çok iyidir. Bu reçineler 300 ºC’ye kadar
sürekli, asbest lifleriyle donatılmaları halinde ise kisa süreli olarak 1000 ºC’ye
kadar kullanılabilmektedirler.

Kullanım Alanları: Elektrik malzemesi ve eşyası yapımı, askeri amaçlı olarak
özellikle mayın yapımında, katı kalıp bileşenlerinde

Şekil 12. 600-800 Ohm Termistörler Aşırı Akım Koruması [17]

Şekil 13. Rus yapımı TM-46 patlayıcılı tanksavar mayını 
[18].



iii. Kompozit Malzeme Yapımında Temel 
Maddelere. Silikon Reçineler

Silikon reçineler, diğerlerinden farklı olarak yapılarında karbon yerine
inorganik esaslı silikonlar bulunan malzemelerdir. Mekanik ve elektriksel
özelliklerini çok az değişikliklerle 250 ºC’ye kadar koruyabilen silikon esaslı
reçinelerin kullanımları, mekanik dayanımlarının diğer reçinelere göre daha
düşük ve maliyetinin de genelde daha yüksek olması nedeniyle kısıtlıdır.
Süpersonik arabalarda kullanılırlar.

Şekil 14. Süpersonik araba [19].



iii. Kompozit Malzeme Yapımında Temel 
Maddeler Tablo 1. Bazı reçinelerin özellikleri [20]



iii. Kompozit Malzeme Yapımında Temel 
Maddelerb. Takviye Malzemeleri

Takviye Elemanlarını Parçacık takviye elemanları, süreksiz takviye elemanları ve sürekli (fiber) takviye
elemanları olarak sınıflandırmak mümkündür [22].

Şekil 15. Kompozit malzemelerin takviyeye göre sınıflandırılması [21].



iii. Kompozit Malzeme Yapımında Temel 
Maddeleri.   Parçacık takviye elemanları

Takviye malzemesinin boyutları, takviye malzeme
özelliklerinin, kompozit malzemeye olan katkısını belirler.
Parçacıklar, çoğunlukla kompozitin sertliğini artırmada
etkili fakat dayanımı artırmada fazla bir etkiye sahip
değillerdir.
Parçacık dolgulu malzemede performansı etkileyen çok
değişik unsurlar vardır. Bunların içinde, parçacık boyutları
boyut dağılımları, yüzey enerjileri, hacimsel oranlar,
homojen dağılıp dağılmadıkları, eksen oranı kompozit
özelliklerini etkiler

Şekil 16. Al matrisli SiC parçacıklı takviyeli kompozit 
malzeme mikroyapısı [23]



iii. Kompozit Malzeme Yapımında Temel 
Maddeler

Şekil 17. Bakır matris içerisinde saçınmış tungstenin elastik modülü-hacim 
oranı grafiği



iii. Kompozit Malzeme Yapımında Temel 
Maddelerii. Elyaf takviye elemanları

Elyaflar kompozit içerisinde farklı tür yapılarda
bulunabilirler. Bunlar sürekli ve süreksiz lif takviyeli
olmak üzere iki şekilde sınıflandırılabilir. En yaygın
kullanılan elyaf malzemelerine; karbon elyaf, cam
elyaf ve aramid elyaf örnek verilebilir. Sürekli elyaf
takviyeli kompozitler anizotropik özelliktedirler.

Şekil 18. Sürekli-süreksiz fiber takviyeli 
kompozit yapısı [21]



iii. Kompozit Malzeme Yapımında Temel 
Maddeler Tablo 2. Bazı elyaf takviyeli malzemelerin özellikleri



iii. Kompozit Malzeme Yapımında Temel 
Maddeler

Şekil 19 . Elyaf takviyeli kompozit malzemesin gerilme-gerinim grafiği



iii. Kompozit Malzeme Yapımında Temel 
Maddeler

Şekil 20 . Takviye elemanına göre katkı oranının-çekme modülüne etkisi [7]



iii. Kompozit Malzeme Yapımında Temel 
Maddeleriii.  Yapısal Kompozitler

Tabakalı kompozitler

Temel malzeme eksenleri doğrultusunda farklı yönlerdeki
tabaka ve katmanların üst üste gelecek bir şekilde
yerleştirilmesiyle oluşmaktadır. Tabakalı kompozitler;
matris içerisinde rastgele yönlenmiş elyaflar, tek yönlü
elyaflar veya farklı türde elyaf takviyeli tabakalardan
oluşabilir

Şekil 21. Tabakalı kompozitlerin yapısal dizilişi ve 
sandviç panellerin yapısı [24].



iii. Kompozit Malzeme Yapımında Temel 
Maddeleriii. Yapısal Kompozitler

Hibrit kompozitler

İki ya da daha fazla takviye elemanının matris ile bir araya
getirilmesiyle oluşturulan daha iyi mekanik özelliklere sahip yeni
malzemelere hibrit kompozitler denir. En çok bilineni cam ve
karbon elyaf takviyeli polimerik reçinelerdir. Hafif kara, su ve
hava taşımacılığı ve spor malzemelerinde kullanılmaktadır.

Şekil 22. Farklı hibrit konfigürasyonlar ve tipik tek-yönlü 
ve iki yönlü örnekler 



2. Kompozit Malzeme Çeşitleri

Bir metalik fazın bazı takviye malzemeleri ile eritme vakum
emdirme, sıcak presleme ve difüzyon kaynağı gibi ileri
teknikler uygulanarak MMC’ler elde edilirler (Yıldırım,
2009).

Kullanım alanları: Daha çok uzay ve havacılık alanlarında

Şekil 23. NASA Hubble Uzay Telekobu [25]  

Şekil 24. Türkiye Uzay Ajansı Uydu Bileşenleri [26]

i. Metal Matris Kompozitler (MMC)



2. Kompozit Malzeme Çeşitleri
i. Metal Matris Kompozitler (MMC)

Şekil 25. Metal matrisli kompozitlerde kullanılan takviye elemanları [27]



2. Kompozit Malzeme Çeşitleri
i. Metal Matris Kompozitler (MMC)

Tablo 3. Sürekli ve yönlenmiş elyafla takviye edilmiş bazı metal matrisli kompozit malzemelerin özellikleri [28]



2. Kompozit Malzeme Çeşitleri
i. Metal Matris Kompozitler (MMC)

Şekil 26. Metal matrisli kompozit malzemelerdeki artan sürtünme direnci değişimi [29]



2. Kompozit Malzeme Çeşitleri
ii.      Seramik Matris Kompozitler (CMC)

Bu amaçla yapısal ve fonksiyonel nitelikli yüksek teknoloji

seramikleri kullanılmaktadır. Başlıcaları Al₂O₃, SiC, Si₃N₄,

B₄C, CbN, TiC, TİB, TİN, AIN’ dir. Bu bileşikler değişik

yapılarda olup amaca göre bir yada bir kaçı beraber

kullanılarak CMC’ ler elde edilir.

Kullanım alanları: Sandviç zırhlar, çeşitli askeri amaçlı

parçalar imali ile uzay araçları

Şekil 27. Seramik matrisli kompozit malzeme örnekleri [30]



2. Kompozit Malzeme Çeşitleri
ii.      Seramik Matris Kompozitler (CMC)

Tablo 4. Farklı SiC visker oranlarında Al2O3 malzemelerinin kırılma dayanımı ve kırılma tokluğu değerleri [31]



2. Kompozit Malzeme Çeşitleri
ii.      Seramik Matris Kompozitler (CMC)

HPSN: Sıcak preslenmiş Silisyum Nitrür   
RBSN: Reaksiyon bağlı Silisyum Nitrür
HPSiC: Sıcak preslenmiş Silisyum Karbür 
a - SiC: Sinterlenmiş Silisyum Karbür 
PSZ: Kısman Stabilize edilmiş Zirkonya 

Şekil 28. Seramik kompozitlerin yüksek sıcaklık mukavemetleri [32]



2. Kompozit Malzeme Çeşitleri
iii.      Polimer Matris Kompozitler (PMC)

Liflerle pekiştirilmiş polimer kompozitler endüstride çok geniş

kullanma alanına sahiptir. Pekiştirici olarak cam, karbon, kevlar ve

bor lifleri kullanılır.

Pekiştirici liflerin miktarı arttıkça kompozitin mukavemeti yükselir.

Polimer kompozitlerin en önemli özellikleri yüksek özgül mukavemet

(mukavemet/ özgül ağırlık) ve özgül elastisite modülüdür.

Kullanım alanları: Uçak ve uzay endüstrisinde alüminyum

alaşımlarına tercih edilir.

Şekil 29. Plastik matrisli kompozit malzeme örnekleri [33,34]



2. Kompozit Malzeme Çeşitleri
iii.      Polimer Matris Kompozitler (PMC)

Tablo 5. Rastgele yönlenmiş Cam elyaf takviyeli ve saf haldeki polikarbonatın özellikleri [35]



2. Kompozit Malzeme Çeşitleri
iii.      Polimer Matris Kompozitler (PMC)

Şekil 30. Polimer matrisli kompozit malzemelerdeki artan E/ρ değişimi [29]



2. Kompozit Malzeme Çeşitleri
IV.         Karbon-karbon Kompozitler 

Karbon esaslı matris içerisine karbon fiberlerinin yerleştirilmesi ile

üretilmektedir.

Kullanım alanları: Özgün özelliklerinden dolayı elektronik, otomotiv ve
diğer ulaştırma vasıtaları, savunma sanayi, endüstriyel fırınlar, çevre
ve enerji alanlarında, roket motorları, yüksek performanslı otomobil
frenleri, tren fren balataları ve hava araçları için sürtünme
malzemesi olarak

Şekil 31. Karbon-karbon kompozit malzeme örnekleri [36,37]



2. Kompozit Malzeme Çeşitleri
V.     Nano Kompozitler 

Malzemeyi oluşturan farklı fazlar arasında nano ölçekli tekrar mesafelerine

sahip yapıların bulunduğu çok fazlı katı kompozitlerdir.

Kullanım alanları: Doğada deniz kulağı kabuğu ve kemiğinin yapısında
bulunur.

• Bilgisayar çipleri için ince film kapasitörler

• Yeni yangın geciktirici malzemeler

• Korozyon önleyici bariyer kaplamalar

• Üstün mukavemetli lifler ve filmler

• Yağlayıcı ve streç boyalar
Şekil 32. Nano kompozit malzeme örnekleri [38,39]



3. Kompozit Malzemelerin Üretim Yöntemleri
i.     Açık Kalıp Üretim Yöntemleri 

a.   Elle Yatırma Üretim Yöntemi

En az miktarda ekipman gerektirdiği için en yaygın ve en ucuz açık
kalıplama yöntemidir. Elyaf takviyeleri bir kalıba elle yerleştirilir ve
reçine bir fırça veya rulo ile uygulanır. Bu işlem, tekneler, depolama
tankları, küvetler ve duşlar dahil olmak üzere hem büyük hem de küçük
parçaların üretiminde kullanılır.

Şekil 33. Elle yatırma yöntemi [40,41]



3. Kompozit Malzemelerin Üretim Yöntemleri

Şekil 34. Elle yatırma yöntemi ile üretilen kompozit malzemeler 

a.   Elle Yatırma Üretim Yöntemi



3. Kompozit Malzemelerin Üretim Yöntemleri
i.     Açık Kalıp Üretim Yöntemleri 

b.   Püskürtme Üretim Yöntemi

Bu üretim yönteminde operatör reçine ve kırpılmış elyafları püskürten bir ekipman yardımıyla kalıp yüzeyine
uygulama yapar.

Şekil 35. Püskürtme yöntemi [42,43]



3. Kompozit Malzemelerin Üretim Yöntemleri
b.   Püskürtme Üretim Yöntemi

Şekil 36. Püskürtme yöntemi ile üretilen kompozit malzemeler 



3. Kompozit Malzemelerin Üretim Yöntemleri
i.     Açık Kalıp Üretim Yöntemleri 

c.   Filament/Elyaf sarma Üretim Yöntemi

Sürekli elyafın reçine ile ıslatıldıktan sonra bir makaradan çekilerek dönen bir kalıp (mandrel)
üzerine sarılmasıdır. Sürekli elyafın farklı açılarla kalıba sarılmasıyla farklı mekanik özelliklerde
ürünler elde edilebilir.

Şekil 37 . Elyaf sarma yöntemi [44,45]



3. Kompozit Malzemelerin Üretim Yöntemleri
c.   Filament/Elyaf Sarma Üretim Yöntemi

Şekil 38. Filament/Elyaf sarma yöntemi ile üretilen kompozit malzemeler 



3. Kompozit Malzemelerin Üretim Yöntemleri
ii.     Kapalı Kalıp Üretim Yöntemleri 

a.   Reçine Transfer Kalıplama (RTM)

Kuru elyaf takviyelerin kalıp boşluğuna yerleştirilip, sıvı reçinenin kalıp içerisine enjekte edilmesi
esasına dayanan bir üretim yöntemidir.

Şekil 39 . Reçine transfer kalıplama yöntemi [46,47]



3. Kompozit Malzemelerin Üretim Yöntemleri
a.   Reçine Transfer Kalıplama(RTM)

Şekil 40. Reçine transfer kalıplama yöntemi ile üretilen kompozit malzemeler 



3. Kompozit Malzemelerin Üretim Yöntemleri
ii.     Kapalı Kalıp Üretim Yöntemleri 

b.   Vakum İnfüzyon

Bu yöntem RTM yöntemine ek olarak içerideki havanın dışarı çıkarılması ve reçinenin elyaf içine iyi işlemesi
için vakum kullanılmasıdır.

Şekil 41 . Vakum infüzyon yöntemi [48,49]



3. Kompozit Malzemelerin Üretim Yöntemleri
b.   Vakum İnfüzyon

Şekil 42. Vakum infüzyon yöntemi ile üretilen kompozit malzemeler 



3. Kompozit Malzemelerin Üretim Yöntemleri
ii.     Kapalı Kalıp Üretim Yöntemleri 

c.   Vakum Torbalama

Vakum torbası kullanılarak, ıslatılmış elyafların (el yatırması sonrası) yada prepreglerin vakum altında
sertleşmesi esasına dayalı bir üretim yöntemidir. Bu uygulamada amaç; fazla reçinenin ve hava boşluklarının
kompozit yapı içerisinden alınmasını sağlamak ve yüksek elyaf oranına sahip ürün elde etmektir.

Şekil 43. Vakum torbalama yöntemi [49,50]



3. Kompozit Malzemelerin Üretim Yöntemleri
c.   Vakum Torbalama

Şekil 44. Vakum torbalama yöntemi ile üretilen kompozit malzemeler 



3. Kompozit Malzemelerin Üretim Yöntemleri
ii.     Kapalı Kalıp Üretim Yöntemleri 

d.   Otoklav+Vakum Torbalama

Vakum torbası kullanılarak, ıslatılmış elyafların (el yatırması sonrası) yada prepreglerin vakum altında
sertleşmesi esasına dayalı bir üretim yöntemidir. Bu uygulamada amaç; fazla reçinenin ve hava boşluklarının
kompozit yapı içerisinden alınmasını sağlamak ve yüksek elyaf oranına sahip ürün elde etmektir.

Şekil 45 . Otoklav+Vakum torbalama yöntemi [51,52]



3. Kompozit Malzemelerin Üretim Yöntemleri
d.   Otoklav+Vakum Torbalama

Şekil 46. AV-8B kanat bölümünün karbon fiber-epoksi laminatı kesilerek kürlenmesi için otoklava 
yerleştiriliyor



3. Kompozit Malzemelerin Üretim Yöntemleri
ii.     Kapalı Kalıp Üretim Yöntemleri 

e.   Sıcak Presleme (SMC-BMC-Prepreg)

Hazır kalıplama bileşenlerinin; metal kalıplarda preslenerek ısı ve basınç etkisiyle sertleştirilmesi
esasına dayalı bir üretim yöntemidir. Kompozitlerin seri üretimine uygun bir yöntemdir.

Şekil 47. Sıcak presleme yöntemi [47,53]



3. Kompozit Malzemelerin Üretim Yöntemleri
e.   Sıcak Presleme (SMC- BMC-Prepreg)

Şekil 48. Sıcak Presleme yöntemi ile üretilen kompozit malzemeler 



3. Kompozit Malzemelerin Üretim Yöntemleri
ii.     Kapalı Kalıp Üretim Yöntemleri 

f.   Pultrüzyon

Pull ve Extrusion kelimelerinden türetilmiş sürekli profil, boru vb. kompozit ürünlerin üretimini sağlayan bir
yöntemdir. Reçine banyosunda emdirilmiş elyaf fitillerinin yada kumaşların sıcak kalıplardan geçirilerek
şekillendirilmesi ve sertleşmesini takiben makine hattı boyunca çekilmesi ve belirli boyutlarda kesilmesi
esasına dayanır.

Şekil 49. Pultrüzyon yöntemi [47,54]



3. Kompozit Malzemelerin Üretim Yöntemleri
f.   Pultrüzyon

Şekil 50. Pultrüzyon yöntemi ile üretilen kompozit malzemeler 



3. Kompozit Malzemelerin Üretim Yöntemleri
ii.     Kapalı Kalıp Üretim Yöntemleri 

g.   Sürekli Laminasyon

Levha formunda kompozit ürünlerin üretiminin sağlandığı prosestir. Özel laminasyon makinelerinde elyaflarla
takviyelendirilen reçinenin ısı ve basınç altında hızlı bir şekilde sertleştirilip soğutulmasını takiben bobinlere
sarılması yada belirli boyutlarda kesilmesi ile elyaf takviyeli kompozit paneller elde edilmektedir.

Şekil 51. Sürekli laminasyon yöntemi [47,55]



3. Kompozit Malzemelerin Üretim Yöntemleri
g.   Sürekli Laminasyon

Şekil 52. Sürekli laminasyon yöntemi ile üretilen kompozit malzemeler 



3. Kompozit Malzemelerin Üretim Yöntemleri
ii.     Kapalı Kalıp Üretim Yöntemleri 

h.   Reaksiyonlu Üretim (RRIM-SRIM)

İki reaktif bileşenin karıştırılarak kalıp boşluğuna enjekte edilmesi ve burada reaksiyon sonucu sertleşmesi
esasına dayalı bir üretim yöntemidir. Bu uygulamada ki reçineler genellikle poliüretan (PUR) olup kimi zaman
disiklopentadien (DCPD)’de kullanılmaktadır.

Şekil 53. Reaksiyonlu üretim yöntemi [47]



3. Kompozit Malzemelerin Üretim Yöntemleri

Şekil 54. Kompozit üretim yöntemleri kullanım oranları



4. Kompozit Yapı/ Parça Mekanik Tasarımı
i.     Fiziksel Prensipler 

• Bütün tasarımlar, geliştirilebilir ya da uyarlanabilir olmalı.

• Tasarım varyasyonları üretim yönteminde ya da fonksiyon değişimi olmadan boyut değişimini 
desteklemeli. Bazen; malzemeyi değiştirmek gerekebilir.

• Ör; küçük tekneler fiberglass’ dan yapılırken büyük tekneler çelikten üretilmektedir [56].



4. Kompozit Yapı/ Parça Mekanik Tasarımı
a.     Malzeme Tasarımı 

• Bir fonksiyonun (elektrik süpürgesi, nükleer reaktör,batarya kutusu…) tanımlanması ile başlanır, bilgi
tabanı oluşturulur ve deneme amaçlı tasarım tecrübe edilir.

• Malzeme seçiminin, tasarımda çok önemli bir yeri vardır.

• Tasarımı sınırlayacak özellikler, her malzeme için mevcut olduğu bilinmelidir.

• İyi bir tasarımda analizlerle birlikte eş zamanlı olarak yaratıcı düşüncenin olması gerekmektedir [56].



4. Kompozit Yapı/ Parça Mekanik Tasarımı
a.     Malzeme Tasarımı 

Şekillendirme, proses ile ilişkilidir.

Şekillendirme prosesleri:

• Birincil işlemler: döküm, dövme….

• Malzeme uzaklaştırma: talaş kaldırma, delme…

• Birleştirme: kaynak, perçinleme….

• Son işlem: boyama, elektro-kaplama…..



4. Kompozit Yapı/ Parça Mekanik Tasarımı
ii.     Uygun Fonksiyonlar

Fonksiyon, malzeme seçimini etkilemektedir. Dolayısıyla, malzeme seçimi, malzemenin dökülebilir,
kaynaklanabilir, ısıl işlem gibi yeteneklerine bağlı olarak prosesi etkilemektedir [56].

Proses; şekil, boyut, hassasiyet ve maliyetin nasıl olacağını açıklamaktadır.

Bu etkileşimler 2 yolla gerçekleşir:

• Şeklin özellikleri, prosesi ve malzeme seçimini sınırlar.

• Aynı derecede prosesin özellikleri son şekli ve malzeme seçimini sınırlar.



4. Kompozit Yapı/ Parça Mekanik Tasarımı
iii.     Tasarım Metodolojisi

Malzeme seçimi ve bileşen dizaynı deneme amaçlı dizaynda malzeme performansının öngörümünde birleştirilir.



4. Kompozit Yapı/ Parça Mekanik Tasarımı
iii.     Tasarım Metodolojisi

Eğer malzeme yüklemelere, momentlere,
konsantre gerilmelere, vb. fazla darbe almadan
veya diğer yollardan çökmeden ya da hasara
uğramadan dayanabilirse dizayn ilerleyebilir.
Eğer malzeme performansı yetersiz kalırsa, ilk
yaklaşım yer alır: ya yeni bir malzeme seçilir veya
bileşen dizaynı değiştirilir ya da her ikisi
gerçekleştirilerek hasarın üstesinden gelinir.



4. Kompozit Yapı/ Parça Mekanik Tasarımı
iii.     Tasarım Metodolojisi

• Bir sonraki kademede malzeme dizaynının spesifikasyonu detaylandırılır.

• Bu kademede detaylı bir gerilme analizi, sistem dinamiği analizi, sıcaklık ve ortama olan 
tepki ve detaylı bir görünüm tasarımı (ürün estetiği) gerektirir. 

• Ayrıca daha iyi malzeme verisini de gerektirir: bu noktada olası distribütörlerden detaylı 
malzeme özellikleri alınması veya kendi seçeceğimiz testler yeterli olabilir [56].



4. Kompozit Yapı/ Parça Mekanik Tasarımı
iii.     Tasarım Metodolojisi

• Dizayn yalnızca ekonomik olarak üretim yapılabilirse
uygulanabilir.

• Üretim ve fabrikasyon seçimi çoğunlukla malzeme seçimi
ile belirlenir.

• Ayrıca üretim rotası, üretim akışı hacminden ve bileşenin
nasıl bitirme işlemlerinin yapıldığından ve diğer
bileşenlerle nasıl birleştiğinden etkilenir.

• Malzeme ve üretim rotası seçimi ile ürün fiyatı belirlenir.

• Eğer maliyet, fiyatın çok yüksek olacağını gösterirse
sonuçta ikinci bir yaklaşım gerekli olabilir.

• Bu durumda alternatif bir üretim yolunu içeren yeni bir
malzeme veya komponent dizaynı seçimi düşünülmesi
gerekebilir[56].



4. Kompozit Yapı/ Parça Mekanik Tasarımı
iii.     Tasarım Metodolojisi

• Bu kademede bir prototip ürün üretilir ve ürünün pazardaki
performansı değerlendirilir. Eğer tatmin edici bir düzeyde ise
endüstriyel boyutta üretim düzeni kurulur.

• Fakat bu noktada dizayn edenin rolü sona ermez. Bir
komponentin sürekli analizi, güçsüz yanları veya performans
arttırma yolları ya da çok daha ucuza yapılabilmesini ortaya
çıkarır.

• Her zaman yeni buluşlar için fırsat vardır: radikal bir yeni dizayn
veya bileşenin imal edildiği malzemede radikal bir değişim.

• Başarılı dizaynlar sürekli olarak değişim gösterir ve yalnızca bu
şekilde ürün, pazardaki rekabetçi konumunu muhafaza eder[56].



5. Kompozit Yapıların Modellenmesi
i.     Geometrinin Modellenmesi

• Bir CAD programında oluşturulan bir yüzey modeli, kompozit modelleme ile çalışırken genellikle
başlangıç olarak kullanılır.

• Bu yüzey modelinde tasarımcı, farklı malzeme biçimlerini modelleme ve simüle etme yeteneğine
sahiptir.

• Kompozit malzemelerle çalışırken izotropik malzemelere göre en büyük fark, kompozitlerin iç
yapısının tanımlanmış olmasıdır[57].



5. Kompozit Yapıların Modellenmesi
ii.     Kompozit Malzeme Yapısının  Modellenmesi

• Analistler, farklı yapılandırmaların hızlı değerlendirmeleri için genellikle idealleştirilmiş bir bileşik
model kullanır [57].

• Tasarımcı ise daha detaylı bir modelle çalışabilmelidir.

• Tasarımcı, tipik olarak analiz edilen idealize edilmiş parçayı değil, doğru bir analiz elde etmek için
nihai şekil üzerinde gerçek elyaf yönelimleriyle çalışmalıdır. Ortaya çıkan laminatlardaki lifler,
belirtilen kat yönlerinden önemli ölçüde saparak, özelliklerde bilinmeyen varyasyonlara neden olur.

• Nihai tasarım, orijinal analizde dikkate alınmayan ek katlar da dahil olmak üzere birçok ayrıntı ve
modifikasyon içerecektir.



5. Kompozit Yapıların Modellenmesi
ii.     Kompozit Malzeme Yapısının  Modellenmesi

DRAPE SİMULASYONU

YERLEŞTİRME TANIMI

KATMAN OLUŞTURMA

MALZEME SEÇİMİ

Genel proses şeması aşağıdaki gibidir [57].



5. Kompozit Yapıların Modellenmesi
iii.     Yüzeylerin Geometrisi

• Malzemeleri etkili bir şekilde kullanmak için temel bir yüzey geometrisi anlayışı gereklidir.

• Mühendislik analizlerinin bu amaçları için, yüzeyler genellikle düz plakalara veya kavisli kabuklara
bölünür.

• Levha yapılarıyla karşılaştırıldığında, kabuklar genellikle eğriliklerinin bir sonucu olarak üstün güç ve
sertlik sergilerler.

• Yüzey geometrisi optimize edilerek, mekanik performanstaki artışla birlikte ağırlık tasarrufu
sağlanabilir.

• İyi dökülebilirliğe sahip takviye malzemeleri, malzemenin yüzeylere katlanmadan veya yırtılmadan
tutunmasına izin vererek, doğrudan kayma kabiliyetlerinden kaynaklanır [57].



5. Kompozit Yapıların Modellenmesi
ıv.     Gauss Eğriliğinin Etkisi

• Bir malzeme tabakasındaki kayma distorsiyonu miktarı, yüzeyin eğrilik derecesine ve levhanın
boyutuna bağlıdır.

• Yüzeyin eğriliği, yüzeyin iki ortogonal ana yönde çarpımı olan 'Gauss eğriliği' adı verilen skaler bir
nicelik ile uygun bir şekilde ölçülür [57].

• Gauss eğriliği, yüzeyler üzerine jeodezik çizgiler çizilerek kolayca görselleştirilebilir.

• Bir noktada paralel olan bir çift çizgi, sırasıyla pozitif, sıfır ve negatif eğrilikli yüzeylerde yakınsama,
paralel kalma veya uzaklaşma eğiliminde olacaktır.



5. Kompozit Yapıların Modellenmesi
ıv.     Gauss Eğriliğinin Etkisi

Şekil 55. Farklı gauss eğrilikleri, pozitif, sıfır ve negatif eğrilik [57]

Uzunluk ekseni boyunca eğrilik olmadığı için silindir, sıfır Gauss eğriliğine sahiptir [57].

Tüm 'geliştirilebilir' yüzeyler (yani, düzleminde malzeme kayması olmadan düz bir levhadan yuvarlanabilenler), tüm
alanları boyunca zorunlu olarak sıfır Gauss Eğriliğine sahiptir.

Son olarak, iki farklı yönde eğriliği olan bir parçanın negatif bir Gauss eğriliği vardır.



5. Kompozit Yapıların Modellenmesi
v.     Kompozit Modelleme Yazılımı

• Kompozit modeller, geleneksel olanlardan çok daha karmaşıktır. Örneğin, bir yarış arabası
monokoku tipik olarak birkaç bin kattan oluşur.

• Özel kompozit araçları olmadan bu katların kullanımını incelemek ve takip etmek neredeyse
imkansızdır.

• Yazılım araçları, karmaşık yüzeylerin dökümünün simüle edilmesini mümkün kılar.

• Simülasyon drape ile, kırışıklıklar ve dokumanın bozulması gibi olası üretim sorunları erken bir
aşamada keşfedilebilir.

• Tipik bir kompozit parça, her biri benzersiz bir şekle, yönelime ve konuma sahip olan, çeşitli
malzemelerin onlarca veya yüzlerce ayrı katından yapılır.

• Her bir katmanın, bir sac levha parçasının tamamından daha fazla bilgiye sahip olması muhtemeldir.
Bu karmaşıklık, çoğu durumda bir parçanın nihai tasarımının hiçbir zaman üretim durumunda analiz
edilmemesi gerçeğiyle birleşir [57].



6. Ürün Oluşturma ve Ürün Tanımı

Kompozitlerin teknik çiziminde, metal yapıların çiziminden farklı olarak, yalnızca geometriyi
açıklayan teknik çizimler değil, aynı zamanda kompozit malzemenin yönünü açıklayan çizimlerin
de olması gereklidir.

Şekil 56. Fibersim ile oluşturulmuş parça örneği [58]



6. Ürün Oluşturma ve Ürün Tanımı
i.     3B Katı Model Oluşturma

Elektronik model için katı modeller, CAM araçları ve
eşleşen kalıplar vb. için başlangıç noktası oluşturmak üzere
otomatik olarak laminat yüzeyler oluşturan FiberSim gibi
kompozit tasarım araçları ile oluşturulurular.

Program, kat sayısını kalınlık yönünde takip eder ve üst ve
alt katları kullanarak yüzeyler oluşturur. Şekil 57. Rulo genişliği içinde düz modellerin 

oluşturulması için kat birleştirme [59].



6. Ürün Oluşturma ve Ürün Tanımı
ii.     Geometrik Teknik Çizimi

Geometri çizimi, metal için kompozit yapılarla
aynıdır [57].

Geometrinin genel temsil kuralları, kompozit
malzeme ile ilgili herhangi bir kaygı olmaksızın
kullanılabilir.

Şekil 58. a) Çentikli fiberin geometrik modeli ve J integral değerlendirmesi 
için Γ konturunun detayı, (b) çatlak ucu bölgesinin sonlu eleman 

meshlenmesi, (c) 1/4 modelinin global sonlu eleman meshlenmesi [60].



6. Ürün Oluşturma ve Ürün Tanımı
iii.     Malzeme Oryantasyonunun Teknik Çizimi

• Bir kompozit modelin homojen bir bileşenle karşılaştırıldığında karmaşık yapısını/doğasını
yansıtan bir kompozit bileşen oluşturmak için büyük miktarda üretim verisi gerekir.

• Çizim veya tasarım paketleri, katman yönünü, yığın içindeki konumunu ve sınırlarını
tanımlamalıdır [57].



a.   Çizim Standartları

• Standartlar, çeşitli endüstrilerde kompozit tasarımda genel kabul görmüş 'en iyi
uygulamayı' somutlaştırmak için kullanılır.

• Avrupa havacılık ve uzay endüstrileri birliği AECMA, kompozitler için bir dizi standart
geliştirmiştir.

• Bu standartlar, kompozit malzemelerden yapılmış parçaların teknik resimlerde
gösterilmesine ilişkin genel kuralları kapsar [57].

6. Ürün Oluşturma ve Ürün Tanımı
iii.     Malzeme Oryantasyonunun Teknik Çizimi



6. Ürün Oluşturma ve Ürün Tanımı
ıv.     Kompozit Çizim Örnekleri

Kompozit bir bileşenin iç yapısını tanımlamanın farklı yolları vardır. Karmaşıklığa bağlı olarak,
farklı yaklaşımlar kullanılabilir.

a. Tabaka Yön Kodları

Örneğin, sabit kalınlığa sahip bir kompozit levha gibi basit geometriler için çizim çok basittir.
Burada standart bir tabaka yönlendirme kodu kullanmak mümkündür [57].



6. Ürün Oluşturma ve Ürün Tanımı
ıv.     Kompozit Çizim Örnekleri

Yeterli bir kod :

1) bir referans eksene göre her bir tabakanın oryantasyonu

2) her bir oryantasyondaki tabaka sayısı ve

3) tabakaların kesin geometrik dizisi belirtilmedir [57]

Şekil 59. Standart tabaka kodları örnekleri [57] 

a.   Tabaka Yön Kodları



6. Ürün Oluşturma ve Ürün Tanımı
ıv.     Kompozit Çizim Örnekleri

b.  Kompozit Tasarım Çizimi

Kalınlıklarında farklılıklar olan parçalarla uğraşırken
çizim, katların nereden başlayıp nerede bırakıldığını
açıklayabilmelidir.

Şekil 60 . Kompozit tasarım çizim örneği [57]



6. Ürün Oluşturma ve Ürün Tanımı
ıv.     Kompozit Çizim Örnekleri

c.  Üretim Referans Yazılımı (Ply Book)

• Katmanlı kompozitlerin tasarımını, analizini ve üretimini entegre etmek önemlidir
• Özellikle incelenen modelin imal edilen parçaya eşdeğer olması önemlidir.
• Bu nedenle, tasarım ve üretim verilerini içeren bir üretim referans yazılımı çok faydalı olacaktır.
• Üretim referans yazılımı, kompozit parçalar için bir tür pedagojik çizimdir.
• Bazen çok sayıda katman nedeniyle, üretim referans yazılımı genellikle HTML biçiminde sunulur.
• Her katman, numaraya göre listelenir ve karşılık gelen bir yerleştirme görüntüsüne bağlanır [57].

Şekil 61. Ürün referans yazılımı oluşturma [61]



6. Ürün Oluşturma ve Ürün Tanımı
ıv.     Kompozit Çizim Örnekleri

d.  CAM

• Kompozit bir parça, her birinin kendine özgü şekli olan yüzlerce farklı kattan
oluşabileceğinden, bu farklı şekilli katları kesmek için çok çalışma yapılır, bkz. şekil
...

• Bu işlemi elle kesmeye kıyasla daha etkili ve daha az zaman alıcı hale getirmek için
genellikle NC kontrollü kesme makineleri kullanılır.

• Birçok özel kompozit CAD aracının, sözde 2 boyutlu düz kalıpları otomatik olarak
oluşturan bir işlevi vardır.

• 2 boyutlu düz model şekli farklı formatlarda üretilebilir. Üretilen formatlar IGES
veya DXF'dir. DXF formatı tipik olarak yerleştirme ve kesme makinelerini
çalıştırmak için kullanılır. Şekil 62. 3B den 2B modele geçiş örneği [62]  



7. Sonlu Elemanlar Analizi (FEA)

• Sonlu elemanlar metodu; uçak, otomotiv, inşaat, akışkanların hareketi,
manyetik akı vb. uygulamalarda karşılaşılan problemlerin çözümünü
kolaylaştırmak amacıyla kullanılan ve gerçeğe çok yakın çözümler veren
nümerik analiz yöntemidir.

• Bu yöntemle, incelenmek istenilen cismin sonlu sayıda küçük elemana
bölünerek inceleme yapıldığı için Sonlu Elemanlar Yöntemi (The Finite
Element Methot) olarak adlandırılır.

• Kapalı biçim çözüm yönteminin kullanımının mümkün olmadığı veya çok
güç olduğu yerlerde problemin çözümü sonlu elemanlar metoduyla
rahatlıkla yapılabilir [22].

Şekil 63. FEA analizi ile çizilmiş bir parça örneği [63]



7. Sonlu Elemanlar Analizi (FEA)
i.     Sonlu Eleman Metodunun Çözümü

Bu metot ile çözüm yapılırken izlenmesi gereken yol;

1. Yapıyı ya da sürekli elemanı birim elemanlara bölmek. Bu yapılırken birim elemanın boyutunu ve şeklini, malzemenin fiziki özelliklerine göre seçmek
gerekir

1. Sonlu elemanlar birbirine düğüm noktalarından bağlanmış kabul edilirler. Bu düğüm noktalarının yer değiştirmeleri, basit yapıların analizlerinde olduğu
gibi, problemin bilinmeyen ana parametreleridir.

1. Her bir sonlu elemanın yer değişimini tanımlamak için düğüm noktalarının yer değişimleri cinsinden fonksiyon seçilir (genelde bir polinomdur,
polinomun derecesi değişimleri birim elemanın düğüm sayısına bağlıdır).

1. Elemanla yer değiştirme fonksiyonları seçildikten sonra her bir elemanın özelliklerini ifade eden matris denklemleri oluşturulur. Bunun için dört
yaklaşımdan biri kullanılır. Bu yaklaşımlar; I. Direkt Yaklaşım, II. Varyasyonel Yaklaşım, III. Ölçülmüş Kalıcı Yaklaşım ve IV. Enerji Dengesi
Yaklaşımı’dır[22].



7. Sonlu Elemanlar Analizi (FEA)
i.     Sonlu Eleman Metodunun Çözümü

5. Elemanlara bölünen sistemin özelliklerini toplamak gerekir. Bunu da elemanların matris denklemlerini birleştirerek sistemin davranışını ifade eden
matris denklemleri oluşturmakla yapabiliriz. Sistemin matris denklemleri bir elemanın matris denklemleriyle aynı formdadır. Fakat sistemde
denklemlerin terim sayısı fazladır.

6. Düğüm noktalarına toplanmış kabul edilen ve sınır gerilmeleri dengeleyen kuvvetler ile düğüm noktalarının yer değiştirmeleri arasında;

│P │ = │K │ x { U }

│P │ : Sütun matris olup dış kuvvetlerin tamamını göstermektedir.

│K │ : Sistemin toplam katılık (direngenlik) matrisidir.

{ U } : r, θ, z yönündeki düğüm yer değiştirmelerini gösteren sütun matrisidir.

• Matris denklemi ile sonlu elemanlar metoduna giriş yapılır. Sonuç olarak bu denklem gösteriyor ki │K │oluşturulan cismin birim yer değiştirmesi için gerekli
kuvveti temsil etmektedir. Yani cismin sonlu elemanlar modelini bir denge yayı olarak düşünürsek,│K │bu yayın yay sabiti (direngenlik sabiti) olur. Böylece
sonlu elemanlar metodunun esası cismin direngenliği bakımından yapılan analizi olmuştur.

• Verilen sınır şartları ve dış kuvvetler etkisi altındaki cismin düğümlerinin yer değiştirmesi bulunur. U, cismin gerilme ve yer değiştirmesinden hesaplanır.
Verilen sınır şartları ve dış kuvvetler ile cismin düğümlerinin yer değiştirmesi bulunur [22].



7. Sonlu Elemanlar Analizi (FEA)
ii.     Eleman Şeklinin Seçilmesi

• Eleman şeklinin seçimini verilebilen bir cismin alt bölmelerinin özellikle iç ve dış sınır şartlarının şeklini
belirlerken şekil geometrisine göre seçilecektir.

• İki boyutlu şekillerde dörtgen ve üçgen elemanlar oluşturmak yerine, eğrisel ve dik açılı elemanlar oluşturmak
daha kullanışlıdır.

• Üç boyutlu cisimlerde ise tetrahedron(üçgen prizma) daha kullanışlıdır.

• Cismin şekline bağlı olarak bazen bu elemanların karışımından oluşan bir bölme oluşturmakla mümkündür [22].



7. Sonlu Elemanlar Analizi (FEA)
iii.     Sonlu Elemanlar Yönteminin Diğer Yöntemlere Göre Avantajları

• Sonlu elemanlar yöntemi ile verilen şekil ne kadar karışık olursa olsun, şekle ve boyutlarına esneklik
kazandırmaktadır.

• İlgili olduğu alanlar arttırılabilir.

• Değişik malzeme özellikleri ve geometrisinde farklı güçlükler ortaya çıkmaz.

• Genel katılık maddesiyle ilişkili kuvvet ve yer değiştirmesi bakımından formüle edilmiş neden sonuç ilişkisi
problemidir. Bu durum sonlu elemanlar metoduyla problemin çözümünü kolaylaştırır.

• Sınır şartları kolayca tespit edilir.

• Sonlu elemanlar metodunun esnekliği sayesinde çok yönlü karmaşık yapılarda diğer problemlerdeki sonuç ilişkisinden
daha etkin olarak kullanılır. Sonuçları diğer analitik veya deneysel metotlarla daha iyi karşılaştırılabilir.



8. Kompozit Malzeme Analizi ve Modelleme
i.     ANSYS Programının Genel Tanıtımı

Mühendislik alanında sonlu elemanlar yöntemiyle çeşitli konularda analiz yapan
programdır [22]. Bu konular;

• Yapısal Analiz

• Termal Analiz

• Elektromanyetik Analiz

• Akışkan Analizleridir.

Şekil 64. ANSYS ile kompozit malzeme tasarım örnekleri [64]



8. Kompozit Malzeme Analizi ve Modelleme
ii.     ANSYS Programının Genel Kullanımı

Programı çalıştırmak için START menüsünden programlar altında ANSYS adlı menü altından INTERACTIVE seçeneği kullanılır. Aynı
menü altında RUN INTERACTIVE NOW seçeneği ise bir önceki yapılan çalışmanın default loading işlemidir. Açılan pencereden
ANSYS’in ilk seçimleri yapılır. Bunlar;

• Enable ANSYS Paralel Performance: Bu modülü etkin kıldığımız zaman, program çift işlemci çalışır ve komplike
problemleri veya hassas mesh’lenmiş parçaların çözüm zamanı azalır.

• Drop Test Module: Bu modül etkinleştirilmesi için ANSYS/LS-DYNA tipinde çalışılması gerekmektedir.

• Working Directory: Yaptığımız çalışma esnasında save dosyalarının korunması ve çeşitli hata mesajlarının saklanması için
Hard Diskteki çalışma klasörüdür. Bu klasöre ayrıca yapılan animasyonlarda default olarak save edilir[22].



8. Kompozit Malzeme Analizi ve Modelleme
ii.     ANSYS Programının Genel Kullanımı

• Graphics Device Name: Grafikler için görüntü bağdaştırıcı seçimi buradan yapılır. Nodal renklendirmenin üç boyutlu
olmasını istiyorsak bu modülü kullanmalıyız.

• Memory Requested: Programın çalışma esnasında bellekten kullanacağı alanı gösterir. Bu default değerler
değiştirilebilir. Değerlerin arttırılması programın performansında bir değişiklik yapmaz, ancak programda uzun süre
çalışılacaksa arttırılması nispeten daha randımanlı sonuçlar vermektedir.



8. Kompozit Malzeme Analizi ve Modelleme
ii.     ANSYS Programının Genel Kullanımı
Ansys Workbench Programının Açılması
Başlat (Start )> Programlar > ANSYS 10.0> ANSYS Workbench [65]



8. Kompozit Malzeme Analizi ve Modelleme
Ansys Workbench Programının Açılması

Modüllerin bulunduğu aşağıdaki pencere açılır. WorkBench’de çalışmamızın her bir ana aşaması farklı modüllerde yapılır [53].

Şekil 65.. WorkBench Modülleri



8. Kompozit Malzeme Analizi ve Modelleme
Program Modüllerinin Tanıtımı

Empty Project: Boş bir çalışma sahası (Proje) açar. Çalışma ile ilgili tüm dosyalar bu sahanın içinde kaydedilir.
Proje kaydedilirse ona bağlı tüm çalışmalar kaydedilir

Geometry: Geometrik modelinin oluşturulduğu modül.

Simulation: Analizin yapıldığı ve Sonuçların Görüldüğü modül.

CFX-Mesh: Yüksek kalitede elemanlara ayırma (meshing) işleminin yapıldığı modül.

Open: Daha önce kaydettiğiniz dosyaları açabilirsiniz [65].



8. Kompozit Malzeme Analizi ve Modelleme
Program Modüllerinin Tanıtımı

Workbench’te yeni bir proje (çalışma sahası) oluşturulduğunda, veritabanı (database) dosyaları da otomatik olarak oluşur.
Örneğin, Design Modeler modülünü çalıştırdığımızda bu modüle ait veritabanı dosyası da otomatik olarak oluşur. Bu
dosyalar proje isminde, her modüle ait farklı uzantılarda oluşur. Örneğin “deneme” isminde proje oluşturursak,

Workbench proje veritabanı dosyası: deneme.wbdb
DesignModeler veritabanı dosyası: deneme.agdb
CFX-Mesh veritabanı dosyası: deneme.cmdb
Simulation veritabanı dosyası: deneme.dsdb
Engineering Data veritabanı dosyası: deneme.eddb



8. Kompozit Malzeme Analizi ve Modelleme
Workbench de Dosya Oluşum Mantığı ve Çalışma Düzeni [65]

Workbench’de öncelikle çalıştığımız konuya (projeye) bir isim belirleriz. (Örneğin, jant optimizasyonu, flans dizayni, bitirme tezim,gibi).

Bu durumda bu proje (Project) bir çalışma sahası gibi düşünülür ve bu saha içinde birden fazla model (Geometry) ve analiz (Simulation)
yapılabilir.

Sonuçta sadece projeyi kaydederseniz ona bağlı olan herbir model ve analiz dosyaları da kaydedilmiş olur.

komutuyla veya File>Save as.. komutuyla kaydedebilirsiniz.



8. Kompozit Malzeme Analizi ve Modelleme
Workbench de Dosya Oluşum Mantığı ve Çalışma Düzeni

• Workbench’e tekrar girdiğinizde önce projenizi açarsanız onun altındaki model ve analizlerin kaydedildiğini görürsünüz.

• Proje windows’daki klasörlere; proje altında yapılan model ve analizler bu klasörün içindeki dosyalara karşılık gelir. Ancak
oluşturduğunuz proje için windows da ayrı bir klasör oluşmaz; .wbdb uzantılı bir dosya olarak bulunur.

• Workbench’de önce projenizi ve daha sonra ona bağlı diğer alt birimleri (modülleri) açmanız düzenli bir çalışma için önemlidir [65].



8. Kompozit Malzeme Analizi ve Modelleme
Workbench de Bir Uygulama

Aşağıdaki adımları takip ediniz.
• Workbench’ e girdikten sonra Empty Project butonuna basınız. Ekran aşağıdaki gibi açılır [65].



8. Kompozit Malzeme Analizi ve Modelleme
Workbench de Bir Uygulama

Aşağıdaki adımları takip ediniz.
• Save as butonuna basarak projenize “yapisal-gerilme-analizi” ismi verip uygun bir klasör içine kaydediniz. Türkçe karakter

kullanmayınız.



8. Kompozit Malzeme Analizi ve Modelleme
Workbench de Bir Uygulama

Aşağıdaki adımları takip ediniz.
• Proje ekranında iken soldaki butonuna basınız.
• Eğer sorulursa boyut olarak mm seçiniz.



8. Kompozit Malzeme Analizi ve Modelleme
Workbench de Bir Uygulama

• Aşağıdaki Design Modeler ekranı açılır [65].



8. Kompozit Malzeme Analizi ve Modelleme
Workbench de Bir Uygulama

• Bu ekranda iken Save as butonuna basarak geometrik modelinizi model-1 isminde kaydediniz (Hiçbir geometri olmamasına
rağmen boş olarak kaydediyoruz) [65].



8. Kompozit Malzeme Analizi ve Modelleme
Workbench de Bir Uygulama

• Üstteki butonuna basarak Project ekranına geri dönünüz.
• Bu ekranda iken butonuna tekrar basınız. Bu durumda aynı proje içinde farklı bir model oluşturabilirsiniz.

Burada da bu geometriyi boş olarak bırakalım ve kaydetmeyelim.
• Şimdi Workbench’den tamamen çıkmak için ekranın .sağ üstündeki tuşuna basınız.

Project modülü ekranı karşımıza çıkar ve bu ekranda, Projemiz, ona bağlı geometriler görülür. Yaptığımız son geometriyi
kaydetmediğimiz için “Unnamed” olarak görülecektir.



8. Kompozit Malzeme Analizi ve Modelleme
Workbench de Bir Uygulama

• Bu ekranda iken butonuna basarsak son yaptığımız geometri (Unnamed) kaydedilmeden WorkBench’den
çıkarız. model-1 i önceden kaydettiğimiz için korunur

butonuna basarsak ikinci oluşturduğumuz geometri de unnamed isminde kaydedilerek çıkılır. Bu
geometri içinde bazı çizimler yapmış olsaydık, Save as ekranı açılacak ve bu ikinci modelimize isim vermemiz istenecekti. Ayrıca
projemize isim vermemiş olsaydık onu da kaydetmemiz istenecekti.



8. Kompozit Malzeme Analizi ve Modelleme
iii.     ANSYS Mesh Analizi

modülüne girerek. Tree Outline’ da bulunan Mesh’ in üzerinde iken sağ tıklayıp,.
Insert > Method seçilir.



8. Kompozit Malzeme Analizi ve Modelleme
iii.     ANSYS Mesh Analizi

Details of Method kısmında Method butonunu tıklayalım.
Yanındaki kutucukta eleman tipleri görülecektir. “All Tetrahedrons”
seçersek üçgen, “Hex Dominant” seçersek dörtgen şekilli elemanlara
böler. Biz bu örnekte “Hex Dominant” seçelim.



8. Kompozit Malzeme Analizi ve Modelleme
iii.     ANSYS Mesh Analizi

Eleman Boyutunun Ayarlanması

Tree Outline daki Mesh’ in üzerine tekrar sağ tıklayarak Insert > Sizing seçelim.
Details de Geometry>No Selection kutucuğunu tıklayıp Apply tuşunun
görünmesini sağladıktan sonra, fare ile “üst parça” yı ekrandan tıklayıp seçelim.
Element size’ a ise eleman boyutunu gireceğiz. Buraya da 10 (mm) girelim.

Bu elemanın bir kenarının alması gereken maksimum uzunluğu gösterir.
Böylece üst parça elemanlara ayrılmaya hazır hale geldi.Aynı işlemi
Mesh>Insert >Sizing den itibaren alt parça için tekrarlayarak bir tane daha
“Sizing” ekleyelim. “Alt parça” yı seçip boyut olarak 5 (mm) girelim.



8. Kompozit Malzeme Analizi ve Modelleme

Kontak Bölgesinin ve Elemanlarının Tanımlanması

İki parçanın temas yüzeylerindeki elemanların sayısının, çözüm hassasiyeti açısından daha
fazla olmasında fayda vardır.

Bunun için Mesh üzerine sağ tıklayıp, Insert > Contact Sizing seçelim. Details kısmında,
“Contact Region” sarı zeminde ise None yazan kutucuğu işaretleyelim ve Contact Region
konumuna getirelim.. Eleman boyutu olarak 1 (mm) girelim

Bu sırada modelde kontak yüzeyi farklı renkte görülmelidir. Eğer Contact Region çıkmıyorsa
Tree outline’da Contact üzerinde sağ tuş> Create Auotomatic Contact tuşuna basınız. (Burada
da çıkmazsa modelinizde bir problem olabilir)

iii.     ANSYS Mesh Analizi
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iii.     ANSYS Mesh Analizi

Elemanlara Ayırma

Mesh girdi işlemleri bitti. Tree Outline da Mesh üzerine sağ tıklayıp, “Preview Mesh” i
seçersek modelimizi elemanlara ayırma işlemini yaptırırız. (Bu işlem bittiğinde elemanlar
görünmüyorsa Tree Outline daki Mesh butonuna basınız.) Resimde görüldüğü gibi, “Contact
Sizing” eklediğimiz temas yüzeyleri daha küçük boyutlu elemanlara bölündü [65].

Her analizde “Preview Mesh” işlemini yapmak zorunlu değildir. Eleman sayısı çok fazla,
modelin şekli karmaşık ise, bilgisayarınızın kapasitesine göre mesh işlemi daha uzun sürebilir.
Eleman sayısının artması çözüm hassasiyetini arttıracak ancak işlem süresini uzatacaktır.



9. Kompozit Malzemelerin Avantaj ve Dezavantajları
Avantajlarları

• Yüksek Mukavemet: Kompozit malzemelerin çekme ve eğilme mukavemetleri, birçok metalik malzemeye göre
çok daha yüksektir. Ayrıca kaplama özelliklerinden dolayı, kompozitlere istenen yönde ve istenen bölgede gerekli
mukavemet verilebilir. Böylelikle malzemeden tasarruf yapılarak, daha hafif ve ucuz ürünler elde edilebilir.

• Kolay Şekillendirme: Kompozit malzeme kullanılarak yapılan büyük ve kompleks parçalar, tek işlemle bir parça
halinde kalıplanabilir. Bu da malzeme ve işçilikten kazanç sağlar.

• Elektriksel Özellikler: Uygun malzemelerin seçilmesiyle, çok üstün
elektriksel özelliklere sahip kompozit ürünler elde edilebilir.

• Isıya ve Ateşe Dayanıklılık: Isı iletim kat sayısı düşük malzemelerden oluşan kompozitlerin ısıya dayanıklılık
özellikleri, yüksek ısı altında kullanılabilmesine olanak tanımaktadır. Bazı özel katkı maddeleri ile kompozit
malzemenin ısıya dayanımı arttırılabilir.



9. Kompozit Malzemelerin Avantaj ve Dezavantajları
Avantajlarları

• Titreşim Sönümleme: Kompozit malzemelerin sünekliği nedeniyle, doğal bir
titreşim sönümleme ve şok yutabilme özelliği vardır. Bu sayede çatlak yürümesi olayı da engellenmiş olur.

• Korozyona ve Kimyasal Etkilere Karşı Dayanıklılık: Kompozit malzemeler, hava etkilerinden, korozyondan ve
çoğu kimyasal etkilerden zarar görmezler. Bu özellikleri nedeniyle kompozit malzemeler, kimyevi madde tankları,
boru aspiratörleri, tekne ve deniz araçları yapımında güvenle kullanılmaktadır.

• Kalıcı Renklendirme: Kompozit malzemelere, kalıplama esnasında reçineye ilave edilen pigmentler sayesinde
istenen renk verilebilir. Bu işlem ek bir masraf ve işçilik gerektirmez [66].



9. Kompozit Malzemelerin Avantaj ve Dezavantajları
Dezavantajları

• Hammaddenin pahalı olması: Uçaklarda kullanılabilecek kalitede karbon
m²’lik kumaşının maliyeti yaklaşık 50 $' dır.

• Lamine edilmiş kompozitlerin özellikleri her zaman ideal değildir, kalınlık yönünde düşük
dayanıklılık ve katlar arası düşük kesme dayanım özelliği bulunmaktadır.

• Malzemenin kalitesi üretim yöntemlerinin kalitesine bağlıdır, standartlaşmış bir kalite yoktur.



9. Kompozit Malzemelerin Avantaj ve Dezavantajları
Dezavantajları

• Kompozitler gevrek malzeme olmalarından dolayı kolaylıkla zarar görürler, onarılmaları yeni
problemler yaratabilir.

• Malzemelerin sınırlı raf ömürleri vardır. Bazı tür kompozitlerin soğutularak saklanmaları
gerekmektedir. Sıcak kurutma gerekmektedir. Kompozitler onarılmadan
önce çok iyi olarak temizlenmeli ve kurutulmalıdır. Bazı durumlarda bu zor olabilir. Bazı kurutma
teknikleri uzun zaman alabilmektedir.
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